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WHAT ARE ALL THOSE MENUS AND BUTTONS?
The majority of objects drawn or manipulated by the menu items or the Toolbar
buttons have a “Properties Dialog Box” that is used to set a wide-range of
characteristics/attributes for the object. While a number of these dialogs are
specific to one particular object, most of them are more generic and are used for
several different objects.

In order to avoid repeating the same information over and over, we have placed
that material under “Properties Dialog Boxes” in the What Are the Basics?
section of this manual. If the object you’re working with has one of these more
generic dialog boxes, you will be referred to that area for more specific
information.

MAIN MENU
The strip at the top of the screen is called the “Main Menu.” The words on it —
“File,” “Edit,” “Tools,” “View,” “Arrange,” “Reports,” “Options,” Window,”
and “Help” — represent menus of commands. To open a menu, place the
Selector on the word for the menu item and press the Left Mouse-Button.

Main Menu items open pull-down windows that contain commands.

• Commands followed by an ellipsis ( … ) means there is an additional sub-
window with special options or instructions.

• Dimmed (gray text instead of black) means a command cannot be selected.

• Some commands are followed by a combination of keys (e.g. Ctrl+N). These
are called keyboard shortcuts and are alternatives to using the Mouse. Note:
Do not press the + sign, just press the two keys indicated.

TOOLBARS

The toolbar across the top of the screen contains icons that can be used as short
cuts to the items found in the menus.  Several of the tools contain pull-down
menus that access further shortcuts.  These are identified with a triangle
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pointing down located on the right side of the icon.  Simply click and hold on
the downward triangle to view the other options.  Move the cursor to the tool
that you want and release the mouse button.  That tool is now selected and its
icon will show on the toolbar.

If a tool is grayed out, it means that it is not currently accessible.  If you’re not
sure what tool the icon refers to, move your mouse over the icon and a pop-up
description will tell you what the tool will do.  As you go through this chapter,
you will see each icon and its corresponding menu command along with an
explanation of what each tool does.

The toolbar(s) will change depending on which window (2D or 3D) you
currently have active.

Note: To have the cursor automatically return to the selector tool, turn your
Caps Lock on.

“FILE” MENU ITEMS

The File Menu contains the commands: NEW, OPEN, CLOSE, SAVE, SAVE AS...,
SAVE 3D VIEW…, DOCUMENT SETUP, PRINT SETUP, PRINT PREVIEW, PRINT,
PRINT 3D VIEW, RECENT FILE and EXIT.

NEW (CTRL+N)
Opens a new drawing window and assigns it the name “Untitled.” Use this
command to begin a new railroad plan.
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OPEN (CTRL+O)
Opens an existing railroad plan.

• Click the OPEN button.

• When the dialog box appears, make your selection from the File Name box.

• Click OPEN in the lower right corner of dialog box.

CLOSE

Closes current plan.

SAVE (CTRL+S)
“SAVE” saves a plan as a file using its current name.

SAVE AS

“SAVE AS…” allows you to name a new plan, save the current plan under a
different name or replace an existing plan with the current one.

• Click SAVE AS button.
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• When the dialog box appears, type the plan name in the File Name box.

• Click “Save.” Note: If you’ve already named your plan, no dialog appears.
Your plan is saved again using the same name.

SAVE 3D VIEW

This option allows you to save the 3D view that you currently have on your
screen as a bitmap. The bitmap can then be viewed i other programs like Paint.
You can select the location of where to save the bitmap image.

DOCUMENT SETUP

Sets the Document Size, View Scale, Orientation, Print Scale and Print
Preferences for your plan.

Document Size: Sets the height and width of your plan. Note: The default
setting is “inches, decimal.” To change to another measurement:

• Select “Options” on the Main Menu Bar.

• Select “Preferences” from the pull-down window.
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• Click the triangle to the right of the “Unit” entry in the dialog box.

• Select your preferred measurement.

• Click “OK” in the dialog box and return to “Document Setup.”

View Scale: Sets the size objects appear on your screen — the lower the
number, the larger the objects will appear.

Orientation: Sets the plan position: Portrait = tall; Landscape = wide.

Print Scale: Sets the scale your plan will print out to. The default option is “Fit
to Page,” which prints the entire plan on a single page. Or you can specify the
scale ratio for printouts. The default scale ratio of 1:1 will print out a “real size”
template. For a smaller size, increase your ratio, e.g. 1:5.

Print Preferences: Sets the page alignment and page numbers/scale options.

PRINT SETUP

Selects the printer name, paper and orientation for your plan. The actual print
options may vary depending on the printer and drivers you have. Here are
examples of what you might see. Please refer to the user guides for your printer
and Windows® for more detailed information.

Printer Name: Selects the printer or output destination. (Your current printer
will be listed.) Note: You could also select outputting to a fax.
Properties: Opens a dialog window with several tab screen choices. These tabs
and their contents will vary depending upon your printer. For example, the tabs
for one printer are Main, Paper, and Utility:  while there are only two tabs for
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printing to a fax, Paper and Graphics. The following are an overview of
options you might find on these tabs.

Main:  Might include options for choosing whether you want quality vs
speed, what media type, and what level of final output copy you want, e.g.
360 dpi or photo quality.

Paper: Sets the number of copies, paper size and paper source; printable
area; and printing orientation (Portrait = tall; Landscape = wide).

Graphics: Sets the number of dots per inch, grayscale/halftone, and darkness
for graphics.

      

Orientation:  Sets the printing orientation of the paper. (Portrait = tall;
Landscape = wide).

PRINT PREVIEW

Lets you view —prior to actual printing — how your plan will print.

Click ZOOM IN to enlarge the view and, should you want to enlarge the view
more, either re-click ZOOM IN or click with the magnifying-glass icon that
appeared when you clicked ZOOM IN.

Click Zoom Out to reduce the view. To reduce it further, click Zoom Out again.
You will also see a magnifying glass like the one you saw with Zoom In. It
operates just as it did before. Clicking it will enlarge the view again.

Click on CLOSE to return to your plan.
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If you’re satisfied and want to print the plan, click on PRINT. Note: The Print
Dialog Box automatically appears when you click on PRINT. Refer to the
following instructions to fill out the dialog box and complete printing.

PRINT (CTRL+P)
The Print Dialog sets the Printer Name, Properties, Print to File setting, Print
Range and Copies; and prints the current plan.

Name: Selects the printer or output destination. (Your current printer is listed.)

Properties: Opens a dialog window with two tab screen choices, Paper or
Graphics. Paper sets the number of copies, paper size and paper source; and
reiterates the printing orientation. Graphics sets the number of dots per inch,
grayscale/halftone, and darkness for graphics.

Print to file: Prints to a disk file rather than a printer.

Print range: Sets which pages, or range of pages, to print.

Copies: Sets the number of copies to print and whether they should be collated.

Clicking “OK” begins printing.
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PRINT 3D VIEW

Prints a copy of the current 3D view of your plan. Note: The 3D view must be
the front window.

The Print Dialog sets the Printer Name, Properties, Print to File setting, Print
Range and Copies; and prints the current plan.

Name: Selects the printer or output destination. (Your current printer is listed.)

Properties: Opens a dialog window with two tab screen choices, Paper or
Graphics.

Paper: Sets the number of copies, paper size and paper source; and reiterates
the printing orientation.

Graphics: Sets the number of dots per inch, grayscale/halftone, and darkness
for graphics.

       

Print to file:  Allows you to print to a disk file rather than a printer.
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Print range: Sets which pages, or range of pages, to print.

Copies: Sets the number of copies to print and whether the copies should be
collated.

Clicking “OK” begins printing.

RECENT FILE

Creates a list of the four most recent plans you’ve worked on at the bottom of
the “File” menu. Click on a plan name, and that plan will reopen.

EXIT

Closes the plan you’re working on and exits 3D Railroad. If you have not saved
changes you’ve made to the plan, a dialog box asking if you want to save the
changes will appear.

“EDIT” MENU ITEMS

The “Edit” Menu contains the commands: UNDO, CUT, COPY, PASTE, DELETE,
DUPLICATE, SELECT ALL, and PROPERTIES. Most commands work with
objects or text you’ve selected. Note: If the commands are dimmed, you have
not selected an object or text to edit.
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UNDO (CTRL+Z)
Reverses the last operation you performed. Note: You should use this command
immediately after making a mistake to ensure it will work … it might not be
available for subsequent operations you perform. However, in many cases you
can select it repeatedly to perform multiple undos.

CUT (CTRL+X)
Removes selected object(s) or text and places it on the clipboard. To CUT an
object or text:

1. Choose the Selector tool.

2. Click the object(s) you want to remove.

3. Choose CUT. Note: You can also use the keyboard by holding down the
control key while pressing the letter “X.”

COPY (CTRL+C)
Copies selected objects or text and places them on the clipboard. To COPY an
object or text:

1. Choose the Selector tool.

2. Click the object(s) you want to copy.

3. Choose COPY. Note: You can also use the keyboard by holding down the
control key while pressing the letter “C.”

PASTE (CTRL+V)
Pastes selected object(s) or text from the clipboard onto your plan. To PASTE an
object or text:

1. Choose the Selector tool.

2. Choose PASTE. Note: You can also use the keyboard by holding down the control
key while pressing the letter “V,” or using the tool at the top of the screen.

3. The pasted object will appear and can easily be moved to the desired
position with the Selector tool.
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Note: Since a copy remains on the clipboard, you can continue to paste
additional copies by repeating the PASTE command.

DUPLICATE (CTRL+D)
By duplicating selected objects or text, this performs — in one operation — the
equivalent of a COPY and PASTE. To DUPLICATE an object or text:

1. Choose the Selector tool.

2. Click the object(s) you want to duplicate.

3. Choose DUPLICATE. Note: You can also use the keyboard by holding down
the CTRL key while pressing the letter “D.”

SELECT ALL (CTRL+A)
Selects all objects and text on your plan.

There are two other ways to select all objects on your plan:

• Keyboard: Hold down the Ctrl key while pressing the letter “A.”

• Mouse:

A. Place your Mouse in the extreme upper corner of your plan.

B. Hold the Left Mouse-Button while dragging the Mouse across your
plan to the lower right corner. This selects all the objects on your plan.

C. Release Left Mouse-Button.

You can now manipulate — move, copy, cut or clear — all the objects at once.
To deSELECT, click any unselected place on the plan.

PROPERTIES

Displays the Properties Dialog Box for the selected object. The type of
information in the box varies depending upon the kind of object you’ve
selected. Note: You may select and view information for only one object at a
time: PROPERTIES is dimmed and unavailable otherwise. PROPERTIES can also
be accessed at any time by clicking the Right Mouse-Button on selected objects
or text. Refer to “Properties Dialog Boxes” in the What Are the Basics? section
of this manual for more specific information.
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TERRAIN EDITOR

This option allows you to alter any piece of terrain that you have created with
the Terrain tool.  Select the piece of terrain that you wish to change.  Go to the
Edit menu and choose Terrain Editor.  Right clicking on the piece of terrain,
selecting the Terrain tab when the Terrain Properties dialog box appears and
then clicking on the Terrain editor button can also access the Terrain Editor.

GET LOST OBJECTS

This menu option will allow you to retrieve pieces of track or any type of object
that you may have moved off the current area.  Select Get Lost Objects from
the edit menu and any missing pieces of track, etc. will reappear on your layout.

“TOOLS” MENU ITEMS

Tools are your main drawing aids. The Tools Menu contains: RUN TEST TRAIN,
STOP TEST TRAIN, LAYERS, SET CAMERA POSITION, ROTATE AROUND

ORIGIN, SELECTOR, DRAW, TRACK, DIMENSION, INSERT and LIBRARY. Note:
There is a direct relationship between the Tools Menu items and their
corresponding icons on the Toolbar. You can access a tool by choosing it in
either place.

RUN TEST TRAIN

Creates a train for testing basic layout operation. To place train:
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1. Select RUN TEST TRAIN by clicking on either the Tools menu item or on its
icon on the Toolbar.

  

2. Click the desired location on your plan. The “Train Properties” dialog box
will automatically open.

To set train properties:

Train Object:  Click Browse to use a different train locomotive object.

Car Object: Click Browse to use a different train-car object.

Train Speed: Move slider or click on the arrows to set the speed.

Car Count: Move slider or click on the arrows to set car count.

Color on 2D: Sets the color of the 2D train objects. Click on the color
bar and the Color dialog box opens automatically. Refer to the “Using
Colors and Patterns” in the What Are the Basics? section of this
manual for more specific information.

Train Status: Once your test train is running, whenever it encounters a
bad section of track and stops, this box will identify the problem with
your track layout. To set testing parameters:

•. Select PREFERENCES from the “Options” Menu.

• Select the “Train” tab.

• Complete settings for maximum distance between track
connections, elevation gap between connections, grade, angle
between track connections, and track bend deformation.
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3. Use Left Mouse-Button to drag the train to the desired track location.

4. Click on the test-train engine (marked by line in center of car) with the Left
Mouse-Button to run test train on track, reverse direction or drag the train to
a new location. Note: To change test-train properties or to check train status,
click on the train with the Right Mouse-Button.

5. To delete the test train, use the Right Mouse-Button to click the train and
select DELETE from the pop-up menu.

STOP TEST TRAIN

This will stop any trains you currently have running on your layout. You can
then move or delete the train(s).

LAYERS 

You may occasionally find it useful to keep portions of your plan separate from
other parts. 3D Railroad’s multiple layer support lets you easily accomplish
this. It’s a lot like using different layers of tissue sheets or clear overlays. When
the sheets are stacked together, they look like a complete scene but when you
take them apart you find that each sheet has just a portion of the whole scene on
it so you can change or hide/show it without disturbing the rest of the picture.

You can create, edit and view objects on a single layer, a combination of layers,
or on all layers at once. And, even though it’s easy to create and use multiple
layers, you don’t have to use them if you don’t want to. In fact, most of your
plans will probably only need to use a single layer.

The Layers Control Icon is located on the tool bar at the top of your screen.

You’re actually always using layers because “Layer O” is the default working
layer that the program automatically sets at start up. So, as we said earlier, you
can just go with this single layer or explore the possibilities of using several
different layers. The choice is up to you.

Active Layer: The active layer is the layer you are working on at the particular
moment. Only one layer can be active at a time. You can check to see which
layer it is by looking at the layer display box to the very far right — “Layer 0,”
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“Layer 1,” “Layer 2,” etc. Note: The small boxes — 0 through 7 — displayed
on the Layers Control Panel are only used to show/hide layers, they do not
necessarily reflect the layer you’re working on. Objects on hidden layers do not
appear in the 3D view either. This is particularly useful on slower systems
because it gives faster display updates.

SET CAMERA POSITION

Creates 2D cameras for controlling the 3D-view perspective.

1. Select SET CAMERA POSITION by clicking on either the Tools menu item or
on its icon on the Toolbar.

  

2. Click desired location on plan.

3. Click and hold down Left Mouse-Button to drag camera around your plan.

4. With the selector tool drag handles to reshape camera size, lens and view
angle, or to rotate.

5. Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color; report fields; and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information.
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TO CHANGE ANGLE OF CAMERA VIEW

• The hollow circle at the top of the camera base lets you adjust the size of the
2D camera without affecting the 3D view.

• The hollow circle at the top of the lens controls the camera lens or view
angle and lets you zoom in but see a smaller area, or the reverse.

• The hollow circle at the center of the lens has no effect on 3D view but lets
you adjust the size of the 2D camera lens control.

ROTATE AROUND ORIGIN

Rotates selected objects around a clicked origin point.

1. Select ROTATE AROUND ORIGIN by clicking on either the Tools menu item
or on its icon on the Toolbar.

   

2. Click desired location on plan. Note: An object must be selected prior to
clicking on ROTATE AROUND ORIGIN.

3. Click and hold down Left Mouse-Button to rotate the object around the
clicked origin point. Note: The origin point does not have to touch or even
be near the selected object.

SELECTOR

The Selector tool looks and acts like a pointer or arrow and is essential for
working on your plan.
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Click on SELECTOR in the Tools menu or on its icon on the Toolbar

   

To use the Selector: Move the tip of the Selector arrow over the object you
want to select and click. Small black squares, called handles, will appear when
the object is selected.

You can now manipulate — move, resize, copy, cut, etc. — the object. To
deselect, click on any unselected place on the plan.

To select multiple objects: Hold down the Shift key as you point and click on
each additional object. Note: Another option is to:

1. Place your Mouse beyond the edge of all the objects you want to select.

2. Hold down the Left Mouse-Button while dragging the Mouse across the
objects. All objects surrounded by the resulting dashed-line box will be
selected.

3. Release Left Mouse-Button.

Refer to the “Selecting, Resizing, and Altering Objects” in the What Are the
Basics? section of this manual for more specific information.

DRAW SUB-MENU

The Draw palette includes SKETCH, LINE, BOX, ROUND BOX, ARC, OVAL

POLYGON, SPLINE and TEXT. Each of these commands has a corresponding
icon on the Toolbar.

SKETCH

Draws a “freehand” line or object.
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Select SKETCH by clicking on its menu item or on its Toolbar icon.

  

A pencil appears and is used to draw “free form” lines. When you draw the line
you will notice several things:

• A Status Box appears that tracks the length and width of the square area the
line has covered.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the length and width of the square area the line has covered.

• When you release the mouse, square, black handles appear at each corner of
the area the line has covered. Use these handles to resize the area.

• A “+” sign appears at the lower left of the area selected. Clicking on this “+”
allows you to rotate the area around its center point. Note: The Status Box
and Bar now also reflect the angle change of the area.

Properties: Sets line style, width and color. To access Properties:

1. Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color, report fields, and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
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section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill, appears.

    .

LINE

Draws a line between two points.

Select LINE by clicking on either its Draw menu item or its Toolbar icon.

  

A pencil appears on your plan and is used to draw straight lines.

As you draw a line you will notice several things:

• A Status Box appears that tracks the line’s length and angle.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the line’s length and angle.
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• When you release the mouse, hollow circles appear at each end of the line.
Dragging on these circles allows you to lengthen the line.

• A “+” sign appears at the line’s originating point. Clicking on this “+” allows
you to rotate the line around its center point. Note: The Status Box and Bar
now also reflect the angle change of the line.

Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color, report fields, and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics? section
of this manual for more specific information.

BOX AND OVAL

These tools are used to draw rectangles/squares and ovals/circles.

Select either of these tools by clicking on their menu item or Toolbar icon.
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A pencil appears on your plan window and is used to draw the shapes.

As you draw these shapes you will notice several things:

• A Status Box appears that tracks the shape’s width and height.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the shape’s width and height.

• When you release the mouse, square, black handles appear at each corner of
the shape. Use these handles to resize the shape.

  
• A “+” sign appears at the lower-left handle of the shape. Clicking on this “+”

allows you to rotate the shape around its center point. Note: The Status Box
and Bar now also reflect the angle change of the shape.

•. Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color; report fields; and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill appears.

    .
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ROUND BOX

Draws a rectangle/square box with rounded corners.

Select ROUND BOX by clicking on its Draw menu item or its Toolbar icon.

  

A pencil appears on your plan window and is used to draw a round box.

As you draw the box you will notice several things:

• A Status Box appears that tracks the box’s width and height.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the box’s width and height.

• When you release the mouse, black squares called handles appear at each
corner of the box. Use these handles to resize the shape.

• Two(2) hollow circles also appear at each corner. Click on and move these to
alter the shape of the box’s corner.
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• A “+” sign appears at the lower-left handle of the box. Clicking on this “+”
allows you to rotate the box around its center point. Note: The Status Box
and Bar now also reflect the angle change of the box.

• Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color, report fields, and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill, appears.

ARC

This tool is used to draw arcs on your plan.

  

A pencil appears on your plan window and is used to draw the arc.

As you draw the arc you will notice several things:

• A Status Box appears that tracks the arc’s width and height (2 radii).

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the arc’s width and height (2 radii), as well as the current location of
the Selector.

• When you release the mouse, square, black handles appear at the corners of
the selected arc. Use these handles to resize the arc.
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• Although, they are difficult to see, when you release the mouse, hollow
circles also appear at the ends of the selected arc. Use these circles to
lengthen and continue the arc. Note: The Status Bar now tracks the length
and radius of the arc.

• A “+” sign appears at the lower-left corner of the selected area. Clicking on
this “+” sign allows you to rotate the area around its center point. Note: The
Status Box and Bar now also reflect the angle change of the arc.

• Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color, report fields, and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill, appears.

    .

POLYGON

The polygon lets you draw a series of connected lines to create a multiple-sided
object.
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Select POLYGON by clicking on its Draw menu item or its Toolbar icon

  

A pencil for drawing the polygon will appear on your plan window.

To draw a polygon:

1. Click at the point you wish to start the first side of your polygon.

2. Move to the end point of the first side and click again. Note: You will notice
the line seems to be “stuck” to your pencil until you click at the corner.

3. Repeat Steps #2 & #3 until you’ve returned to the polygon’s starting point.

4. Double click on the starting point to complete the polygon.

As you draw the polygon, you will notice several things:

• A Status Box appears that tracks the total length of the line creating the
polygon, as well as showing the angle of each corner you create.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the total length of the line creating the polygon.

• When you release the mouse, square, black handles appear at each corner of
the area covered by the polygon. Use these handles to resize the polygon.
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• Hollow circles also appear at each angle of the polygon. Use these circles to
change the size of each angle and to lengthen or shorten a particular line
segment.

• A “+” sign appears at the lower-left handle of the selected area. Clicking on
this “+” allows you to rotate the area around its center point. Note: The
Status Box and Bar now also reflect the angle change of the area.

• Click Right Mouse-Button to select PROPERTIES. Properties sets line style,
width and color, report fields, and settings commands. Refer to 2D OBJECT

PROPERTIES under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information. A dialog window with
two tab screen choices, Line and Fill, appears.

    .

SPLINE

Lets you draw a spline-based curve from a series of connected lines.

Select SPLINE by clicking on either its Draw menu item or its Toolbar icon.

  

A pencil for drawing the spline will appear on your plan window.
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To draw a spline:

1. Click at the point you wish to start your curve.

2. Move to the end point of the first segment of your curve and click. Note:
You will notice the line seems to be “stuck” to your pencil until you click at
the corner.

3. Move to the end point of the second segment of your curve and click again.
Note: You will notice that when you click an end point, the square corner
smooths into a curve.

4. Repeat Steps #3 & #4 for a series of curves.

5. Double click to complete your curve(s).

Adjusting Curves: When you release your mouse-button, two(2) hollow
circles and a square appear at each curve of the spline.

Click on one of the circles and move it to alter the shape of the curve. The
hollow box can also be moved along the line to change the location of the
curve.

When you release the mouse, black squares called handles also appear at each
corner of the area covered by the spline. Use these handles to resize the spline.

As you draw the spline, you will notice several things:

• A Status Box appears that tracks the total length of the spline, as well as
showing the angle of each curve you create.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the total length of the spline.

• A “+” sign appears at the lower-left handle of the selected area. Clicking on
this “+” allows you to rotate the area around its center point. Note: The
Status Box and Bar now also reflect the angle change of the area.

• Click the Right Mouse-Button to select PROPERTIES. Properties sets line
style, width and color, report fields, and settings commands. Refer to 2D
OBJECT PROPERTIES under “Properties Dialog Box” in the What Are the
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Basics? section of this manual for more specific information. A dialog
window with two tab screen choices, Line and Fill, appears.

    .

TEXT

The TEXT tool lets you enter text for labels, etc.

Select Text from its Draw menu item or its Toolbar icon.

  

A bar-shaped icon called a cursor will appear on your plan window.

To type and format text:

1. Click and drag your Mouse to define a rectangular area that will hold the
text. A Text properties dialog box will appear with a flashing bar in the upper
left of the text screen.

2. Type in your text.

3. Click on the FONT button … the Font screen will appear.
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4. Set Font properties:

Font: Select font.

Font Style: Select style

Size: Select font size. Note: Sizes for your font choice will automatically
come up. You can set other sizes but the ones displayed will give you the
best printout.

Effects: Click on box to select either of these font effects.

Script: Choose this to set a different, international script, if available.

Sample: Displays a preview of your font choices.

5. If you’re satisfied with what you’ve typed, click "OK". Note: The text
displayed on your Text-properties screen will not reflect your formatting.
However, the formatting will be applied to the text on your plan window.

Your selected text has black handles at each corner of the text area. Use these
handles to resize the text area.

Note: Manipulating the handles will not affect your text. To make changes to
your text:

1. Click on the text with the Right Mouse-Button.

2. Select PROPERTIES.

3. Make your changes.

4. Click “OK.”

As you use the handles, you will notice several things:

• A Status Box appears that tracks the height and width of your text block, as
well as showing the angle of the text.

• A Status Bar appears at the bottom of your monitor screen that tracks the
height and width of your text block, as well as showing the angle of the text.

• A “+” sign appears at the lower-right handle of the selected text. Clicking on
this “+” allows you to rotate the text around its center point.
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• As you change the text-box size, the text lines wrap around if it is needed for
the text to remain within the box.

TRACK SUB-MENU

The Track palette includes the commands: STRAIGHT TRACK, CURVE TRACK,
OVAL  TRACK And SPLINE TRACK. Each of these commands has a
corresponding icon on the Toolbar.

Each track style has its own TRACK  PROPERTIES DIALOG  BOX. Properties
dialog boxes contain the settings for Length, Radius(1), Radius(2), Start angle,
ArcDegrees, Grade %, Elevation1, Elevation2, Railspacing, Tie length, Tie
spacing, Track sep, Show axis, Show ties, Resizable option, Normal/Bridge/
Tunnel, Roadbed Width and Height, and Track and Roadbed Appearance. Refer
to TRACK PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information.

STRAIGHT  TRACK

Draws a section of straight track.

Select STRAIGHT TRACK by clicking on its Draw menu item or its Toolbar icon.

   

A crosshair pointer appears on your plan window and is used to draw a section
of straight track.

As you draw the track you will notice several things:

• A Status Box appears that registers the track’s length and angle.
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• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the track’s length, angle, elevation and grade.

• When you release the mouse, hollow circles appear at each end of the track
section.

Dragging on these circles lengthens the track. Note: Holding the Ctrl key
down while dragging the circles will change the 3D elevation (height) of the
track.

• A “+” symbol appears at the track’s originating point. Dragging this “+”
allows you to rotate the track around its center point.

• Holding the Shift key down while drawing or resizing the straight track will
constrain it to a perfect 45° or 90° angle.

To MOVE a section of track: Move onto the track rails with the selector tools
and drag using the Left Mouse-Button.

Track Properties: Click Right Mouse-Button to select PROPERTIES. Refer to
TRACK PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information.
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CURVED TRACK

This tool is used to place curved track on your plan.

Select CURVED TRACK by clicking on its Draw menu item or its Toolbar icon.

   

A crosshair pointer appears on your plan window and is used to draw the
curved-track section.

As you draw the curved track, you will notice several things:

• A Status Box appears that registers the track’s length and radius.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the track’s length, start angle, arc degree length (measures
counterclockwise from the start angle), radius, elevation at each end and
grade.

• When you release the mouse, hollow circles appear at each end of the track
section.

Dragging on these circles lengthens the track. Note: Holding the Ctrl key
down while dragging the circles will change the 3D elevation (height) of the
track. This operation also causes the status box to register the length and arc
degrees.
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• A hollow square appears at the midpoint of the track. Dragging this square
allows you to adjust the radius size of the track. The status box once again
registers the track’s length and radius.

• A “+” sign appears near the midpoint of the track. Dragging this “+” with the
selector tool allows you to rotate the track around its center point.

To MOVE a section of curved track: Move onto the track rails and drag using
the Left Mouse-Button.

Track Properties: Click Right Mouse-Button to select PROPERTIES. Refer to
TRACK PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information.

OVAL  TRACK

Draws a section of oval track.

Select OVAL  TRACK by clicking on its Draw menu item or on its Toolbar icon.
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A crosshair pointer appears on your plan window and is used to draw a section
of oval track.

As you draw the track you will notice several things:

• A Status Box appears that registers the track’s width and height radii.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the track’s length, start angle, arc degree length (measures
counterclockwise from the start angle), width and height radii, elevation at
each end and grade.

• When you release the mouse, hollow circles appear at each end of the track
section.

Dragging on these circles allows you to lengthen the track. Note: Holding the
Ctrl key down while dragging the circles will change the 3D elevation
(height) of the track.

• A “+” sign appears at the track’s originating point. Clicking on this “+”
allows you to rotate the track.

To MOVE a section of track: Move onto the track rails and drag using the Left
Mouse-Button.

To create a spiral helix: Refer to CREATING A SPIRAL HELIX in the What Are
The Basics? section of this manual.

Track Properties: Click the Right Mouse-Button to select PROPERTIES. Refer
to TRACK PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information.
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SPLINE  TRACK

This tool lets you draw a spline-based section of track from a series of
connected sections. Spline track emulates the bendable flex track you can
purchase in a store. Note: You may find the spline track tool very useful to
emulate flex track, or to connect the ends of two sections of track when a
custom track piece is needed.

Select SPLINE TRACK by clicking on its Draw menu item or Toolbar icon.

   

A crosshair pointer appears on your plan window and is used to draw a section
of spline track.

To draw a section of spline track:

1. Click at the point you wish to start your track.

2. Move to the end point of the first segment of track and click. Note: You will
notice the track seems to be “stuck” to your icon until you click at the end
point.
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3. Move to the end point of the second segment of your track and click again.
Note: You will notice that when you click an end point, the square corner
smooths into a curve.

4. Repeat Steps #3 & #4 for a series of curves. Note: You need only draw one
straight section to create a track with minimal bends to adjust (2 control
points).

5. Double click to complete your spline.

When you release the mouse, black handles also appear at each corner of the
area covered by the spline. Use these handles to resize the whole piece of track
at once.

As you draw the spline, you will notice several things:

• A Status Box appears that registers the spline’s total length and the angle of
the currently drawn track section.

• A Status Bar appears at the bottom of your monitor screen. This bar also
registers the spline’s length, angle, elevations and grade.

• A “+” sign appears at the lower-left handle of the selected area. Dragging
this “+” allows you to rotate the spline. Note: The Status Box now reflects
the rotation angle.

Adjusting Curves: When you release your mouse-button, two(2) hollow
circles and a square appear at each curve. Drag one of the circles to alter the
shape of the curve. The hollow box can also be moved along the track to
change the location of the curve.

To MOVE a section of track: Move onto the track rails and drag using the Left
Mouse-Button.

Track Properties: Click the Right Mouse-Button to select PROPERTIES. Refer
to TRACK PROPERTIES under “Properties Dialog Box” in the What Are the
Basics? section of this manual for more specific information.
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SELECT TRACKS CHAIN 

This is a useful tool if you wish to alter or move more than one piece of track at
a time.  Choose Select Tracks Chain from the Edit menu, or click on the
corresponding icon on the tool bar.  The cursor will now look like a hollow
arrow with a piece of track.  Move the the cursor over the first piece of track
that you wish to alter and cursor arrow will become solid.  Click and hold the
left mouse button.  The track will turn light blue.  Still holding the left mouse
button, move the cursor over each piece of track you wish to select, making
them light blue.  Let go of the left mouse button and you will notice that each
piece of track that you highlighted is now selected.

TRACK WIZARD

This tool allows you to easily and accurately draw the track you want.
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Choosing Track Wizard from the Tools menu, or selecting the wand icon on the
toolbar will open up a dialog box like the one below.

Here you will find tabs that take you to Straight Track, Curved Track,
Crossover, Crossing, Slip Switch, Turnout, 3-Way Turnout, Curved Turnout,
Turntable, Helix Track and Spiral Easement.

STRAIGHT  TRACK

This offers an additional way to create a straight track piece by entering the
exact length of track desired.

CURVED TURNOUT

With this function you can create either curved turnouts or wyes by selecting
the desired constraint option and then filling in the necessary  length, radius,
offset or angle.

TURN TABLE

Create a turntable of any size by entering the required length.  In this version,
turntables don’t automatically function.  We are hoping to include this option in
a future upgrade version.

HELIX  TRACK

Specify grade or total height.  Each of these specifications affects the other.
Specify the radius, the curved track angle (arch degrees), curved track count
(this gives the number of pieces of curved track the helix will be comprised of)
and straight track length (affects the beginning and ending track pieces
comprised in the helix).
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SPIRAL  EASEMENT

Allows you to change the length, radius, and indicates the offset to create the
accurate easement track.

3-WAY TURNOUT

Create a 3 Way Turnout by setting the radius and angle of each branch of the
turnout, as well as the length of the straight segment.

TURNOUT

Set the desired constraints for radius, length, angle or offset to

automatically create a precise turnout.

CROSSOVER

Set either double or single crossover.  With a single you may specify direction
(right or left).  In a double crossover direction does not apply.  Set the length
and separation between track.  The track wizard will automatically set the
curved radius and angles for you.

CROSSINGS

Set the length independently and specify the angle required to create perfect
crossings.

SLIP  SWITCH

Select either a single or double and specify the length and angle to create a
precise slip switch.  The radius is controlled by these measurements.

CURVED TRACK

Specify angle (arch degrees) and radius.

Selecting one of these tabs will bring up an example of the track and allows you
to enter properties including length, angle, separation, and radius, depending on
the type of track.  Defaults have been set for each type of track and can be
restored by clicking on the Default button located in the Track Wizard dialog.
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CONNECT USING SPLINE TRACK

This tool lets you connect two pieces of track using a section of spline track.
Select the first piece of track you wish to connect after selecting the tool from
the tool bar or from the Tools, Track sub-menu.  Hold and drag the arrow to the
piece of track you wish to connect to.  Solid squares will appear if the
connection is valid.  If it’s not, a red circle with a line through it will appear.

  

You can bring up the properties on the new track by Right-clicking on it.  This
will show you the same dialog box as for other track pieces.

CONNECT USING STRAIGHT-CURVE TRACK

This option allows you to connect two pieces of track using a combination of
straight and curved track.  After selecting this option from the menu, an arrow
will appear.  Left-click at the end of the first piece of track that you want to
connect.  Drag the connection arrow to the second piece of track.  Solid squares
will appear to let you know that you can connect the two pieces.  A red circle
with a line through it will appear if it cannot connect at the chosen locations.
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You can bring up the properties on the new track by Right-clicking on it.  This
will show you the same dialog box as for other track pieces.

Note: While both the Spline and Straight/Curve Track connections work in the
same way, you will need to select which type works best for what you want to
achieve.  Spline track is useful when closing a gap that is close to being
straight.  The straight/curve connection is useful when wanting to create an oval
or other section of curved track.

CUT TRACK

This tool, whose icon looks like two pieces of track with an up and a down
arrow separating them, allows you to take one piece of track and cut it into
multiple pieces.  This is effective when you need to create turnouts at specific
locations.

  

Select the Cut Track tool from the Tools menu, or click on the icon on the tool
bar.  Move the cursor to the section of track where you want to cut.  Click on
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that section.  The single piece of track is now two pieces, effectively creating
two different track pieces.

CREATE PARALLEL TRACK

This tool allows you to select one or more track pieces and will automatically
generate a parallel section of track at the desired distance from the original
track.

   

With the parallel track tool, click on the original piece(s) of track.  A cursor that
looks like two vertical lines and an arrow will appear and the piece of track will
turn light blue.  To select more than one piece of track, move the cursor along
each piece of track you wish to duplicate, turning them light blue.  Move the
cursor to a position parallel to the original piece of track.  A line on the right
will show the distance moved.  Click on the desired location.  A dialog box will
appear confirming the offset distance.  If you wish to change the distance, enter
it in the box and hit OK.  A piece of identical track will then appear at a parallel
location to the original piece of track.

SET SELECTED TRACK ELEVATION

This tool allows you to select one or more track pieces and assign a specific
elevation to them.  First select the pieces of track you want to change the
elevations of with the selector tool.  Next, get the Set Selected Track Elevations
tool from either the Tools menu or the toolbar.
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Click and hold on the end of one of the selected sections of track.  A solid
square will appear.  Drag the dotted line to another end part of track, until
another solid square appears and release the mouse button.

A dialog will then appear where you can enter a grade percentage or the
beginning and the end height of the track.

Once you have entered your desired elevation, click OK.  You must make sure
that the chosen track elevation is above the benchwork.  The program cannot
alter the elevation of the track if a piece would then appear beneath the
benchwork.

DIMENSION SUBMENU

You may, on occasion, need to know the size of an area or the distance between
two points; or you may want to mark a location for future reference for
positioning, drawing and aligning objects. The Dimension measuring tools will
be of assistance in such situations.

The Dimension palette includes the commands: DRAW DIMENSION LINE,
DRAW DIMENSION ANGLE, MEASURE LINE and MEASURE BOX. Each of
these commands has a corresponding icon on the Toolbar.
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DRAW DIMENSION  LINE

The Dimension Line draws an editable dimension line. This line allows you to
put length dimensions on your plan to indicate the size of objects or the
distance between two points.

Select DIMENSION LINE by clicking on its Draw menu item or its Toolbar icon,

   

You use the Selector to draw your dimension line by dragging the Selector from
the point you want to measure from, to the point you want to measure to and
then releasing the Mouse button.

As you drag the Selector you will notice several things:

• Two parallel lines, connected by a perpendicular third line appear on your
plan window.

The connecting line measures the distance between the parallel lines and is
marked by arrows at each of its ends.

• A Status Box that tracks the line’s length and angle appears next to the
Selector.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the line’s length` and angle.

• The line’s length appears next to the connecting line.

• When you release the mouse, hollow circles appear at the beginning and
ending points of the parallel lines and at the midpoint of the connecting line.
Dragging on these circles allows you to resize any of the three lines.
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• A “+” sign appears at the starting point of the dimension line. Clicking on
this “+” allows you to rotate the dimension line around the midpoint of the
connecting line. Note: The Status Box and Bar now also reflect the angle
change of the dimension line.

• As long as the dimensions line is SELECTED, THE HOLLOW circles and the
“+” remain visible. As soon as you deselect the line, they disappear, leaving
the dimension lines and the figures noting the length of the measured area.

• To reselect the line, click on either the circles or at any point along the line.

• To MOVE  the line:

Properties Dialog Box: Use the Right Mouse-Button to click on the line. A
dialog window appears with two tabs, Line and Frames. Refer to 2D
PROPERTIES BOX under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information.

   

DRAW DIMENSION  ANGLE

The DIMENSION ANGLE draws an editable dimension line/arc to angles. Use
this tool to indicate the angle dimensions of your plan or to measure the angle
between objects or drawing elements.
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1. Select DIMENSIONS ANGLE on the Draw menu or click on its Toolbar icon,
under the pull-down dimension toolbar icon.

   

2. Click at the point you want to set your angle. Drag a protractor-shaped
object downward to measure outside angles or drag it upward to measure
inside angles. You will see:

• Two intersecting lines, connected by a curved third line near their end
points. This connecting line measures the angle of the intersecting lines
and is marked by arrows at each of its ends.

• There are also four(4) hollow circles: one at the end point of each straight
line and one at their intersection point; another circle is located on the
curved line. Use these circles to resize the line’s length and angle.

• The degree of the angle also appears near the circle on the curved line.
Note: Move the hollow circle on the curved line to adjust the position
of the angle text.

• A “+” sign also appears at the end point of the right line. Clicking on
this “+” allows you to rotate the angle around the intersection point of
the line segments. Note: The Status Box and Bar now also reflect the
rotation angle.

3. To resize the angle or straight lines, click the Selector on one of the circles
located at the end points of the lines. As you move the circles you will notice
several things:

• A Status Box that registers the location of the angle and tracks the
angle’s degree appears next to the Selector Arrow.
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• A Status Bar appears at the bottom of your monitor screen. This bar
also registers the location of the angle and tracks the angle’s degree.

4. As long as the dimension angle is SELECTED, the hollow circles and the “+”
remain visible. As soon as you deselect the angle, they disappear, leaving the
dimension angle and the register of its angle.

5. To reselect the angle, click on any circles or at any point along the lines.

To move the line: select it, click at any point along the line and drag the line to
its new location.

Properties Dialog Box: Use the Right Mouse-Button to click on the line. A
dialog window appears with two tabs, Line and Frames. Refer to 2D
PROPERTIES BOX under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information.

    

DRAW MEASURE LINE

Select MEASURE LINE on the Draw menu or by clicking on its Toolbar icon,
under the pull-down dimension toolbar icon.
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An icon resembling a ruler appears next to the Selector Arrow on your plan
window. Use the Selector Arrow to draw your measured line by dragging the
Selector from the point you want to measure from, to the point you want to
measure to and releasing the Mouse button.

As you draw the line you will notice several things:

• A Status Box appears that tracks the line’s length and angle.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the line’s length and angle.

• When you release the mouse, hollow circles appear at each end of the line.
Dragging on these circles allows you to lengthen the line.

• As long as the MEASURE LINE is selected, the hollow circles and the Status
Box figures remain visible. As soon as you deselect the line, the line and the
figures disappear, and the hollow circles are replaced by hollow squares that
mark the ends of the path of your measured line. Note: Holding down the
CTRL key overrides leaving marker objects.

• To reselect the line, click on either a square or at any point along the
measured path.

• To move the measure line: select it, move on to any point along the line and
drag the line to its new location.

Note: The Properties dialog box is not of use with this measurement other than
to set the font size for the measurement text.

DRAW MEASURE BOX

The MEASURE BOX measures a rectangular area.

Select MEASURE BOX on the Draw menu or by clicking its Toolbar icon, under
the pull-down dimension toolbar icon.
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An icon resembling a ruler appears next to the Selector Arrow on your plan
window. Use the Selector to draw your box by clicking at the point you want to
measure from, dragging the Mouse diagonally across the area you want to
measure and clicking the Mouse again at the opposite corner.

As you drag the Selector you will notice several things:

• A box appears that defines the area you are measuring.

• A Status Box appears that tracks the box’s length, width and area.

• A Status Bar appears at the bottom of your monitor screen. This bar also
tracks the box’s length, width and area.

• When you release the mouse, black squares appear at each corner of the box.
Dragging on these squares allows you to resize the box.

• As long as the box is selected, the box outline and the Status Box figures
remain visible. As soon as you deselect the box, the outline and the figures
disappear, and the black squares are replaced by hollow squares. These
hollow squares mark the corners of the measured area. Note: CTRL
overrides leaving marker objects.

• To reselect the box, click on either a square or at any point along the
perimeter of the measured area. The box and figures will now reappear.

• To move the measure box: select it, move on to one of the box lines, and
drag the box to its new location.

Note: The Properties dialog box is not in use with this measurement other than
to set the font size of the measurement text.

INSERT SUBMENU

Contains the commands: 2D BITMAP PICTURE, 3D BITMAP, 3D OBJECT,
BENCHWORK and TERRAIN.

INSERT 2D BITMAP  PICTURE

Imports a bitmap picture (*.bmp file) and inserts it into the 2D drawing
window.
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Select Insert 2D BITMAP PICTURE by clicking on its menu item or Toolbar icon.

  

An icon resembling an eye appears to define a rectangular area that will hold the
2D picture. A Picture properties dialog box will appear.

Properties Dialog Box: Use the Right Mouse-Button to click on the line. A
dialog window appears with two tabs, Line and Frames. Refer to 2D
PROPERTIES BOX under “Properties Dialog Box” in the What Are the Basics?
section of this manual for more specific information.

INSERT 3D BITMAP

Imports a bitmap picture (*.bmp file) and mask (*.msk), and inserts it into the
3D drawing window.
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Select Insert 3D BITMAP by clicking on its menu item or Toolbar icon.

  

An icon resembling a tree appears to be used to define a rectangular area that
will hold the 3D bitmap. A 3D Bitmap properties dialog box will appear.

Properties Dialog Box: Refer to 3D BITMAP PROPERTIES under “Properties
Dialog Box” in the What Are the Basics? section for more specific information.

INSERT 3D OBJECT

Imports a 3D object. (3D Studio or DXF)

Select Insert 3D OBJECT by clicking on its menu item or Toolbar icon.
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An icon appears to define a rectangular area that will hold the 3D object. When
you draw the rectangle, a 3D Objects properties dialog box appears.

3D Objects Properties Dialog Box: Refer to 3D OBJECTS PROPERTIES under
“Properties Dialog Boxes” in the What Are the Basics? section of this manual
for more specific information.

INSERT BENCHWORK

Draws polygonal benchwork structures that appear in place of the default
benchwork in the 3D view.

Select Insert BENCHWORK by clicking on its menu item or Toolbar icon.

  

An icon resembling a table appears for drawing the benchwork. To draw a
benchwork object:

1. Move to the start point of one side of the anticipated benchwork and click.

2. Drag the side to the desired length and click.
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3. Repeat Step #2 for each side.

4. Double click to complete the object.

Your custom benchwork object(s) now replaces the default benchwork that is
based on the document size. (See DOCUMENT SETUP earlier in this section.)

Clicking on one of the benchwork lines allows you to select “Properties” for the
benchwork.

Benchwork Properties Dialog Box displays two(2) tabs, Line and Benchwork.
Refer to BENCHWORK PROPERTIES DIALOG BOX under “Properties Dialog
Box” in the What Are the Basics? section of this manual for more specific
information.

     

TERRAIN

While 3D Railroad already comes with preset hills and mountains, it also
allows you to make your own terrain.  Select Terrain from the Tools, Insert
submenu, or select its icon from the toolbar.
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When selected, this tool will act much the same way that the benchwork tool
works.

1. Move the terrain icon, which looks like a mountain, to the starting point of
where you want to place your terrain and click.

2. Drag the pointer to the desired length and click.

3. Repeat Step #2 for each side until you have the shape you want.

4. Double click to complete the object.

Once you have double clicked, a dialog box will appear that allows you to enter
information about the new piece of terrain.  The Line tab lets you enter
information including fill, line, and part information like price, scale, etc.

   

Clicking on the Terrain tab will bring up information about the terrain’s grid
spacing, elevation, whether or not to conform the terrain to objects, set fixed
borders and texture.  If you select to conform the terrain to objects, this
property will be applied to all created pieces of terrain, not just the one
currently selected.  Selecting fixed borders will keep all edges of the terrain
fixed to the benchwork. You can choose the texture by clicking on the Browse
button next to the texture entry box.  This will bring up a new dialog where you
can preview and select the terrain texture.

TERRAIN  EDITOR

You will also find a button labeled Terrain editor….  This allows you to
customize your terrain in terms of elevation and shape.  Clicking this button
will bring up a new dialog where you will see a grid, or wire frame, of your
new terrain.  The wire frame is currently flat.  In the center of the wire frame,
you will see a red ball.  Click and hold the red ball with the left-mouse button
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and drag the ball up.  You will notice that the elevation box below will keep
track of the elevation of the peak off the current benchwork.

You can then select different points on the grid by clicking at intersecting points
with the left mouse button, using the arrow keys located at the bottom left of
the dialog box, or using the arrow keys on your keyboard.  You can also enter a
specific elevation in the elevation box and it will be applied to the current point
on the grid.

To get a different perspective on the terrain, use the Rotate Left and Rotate
Right buttons on the right side of the dialog box.  This will move the wire frame
around a center point.  Beneath these buttons, you will find the option to apply
the new elevation to just the selected point, or to the points around them as
well.  Applying the new elevation to points surrounding the selected location
will create a gradual, more realistic increase in elevation.  To zoom in or out on
the wire frame, click any section of the white part of the window with the left
mouse button.  You can now use the arrow keys on your keyboard to zoom in
and out on the grid.

   

You will also find the choice of linear or cubical type of elastic function.
Linear will make the angle of incline steeper.  Cubical makes the incline more
gradual and rounded.  Also, the elastic sensitivity/distance percentage is
alterable.  If you previously chose not to have fixed borders, you will notice
that when you make changes to points close to the edge of the terrain, the edges
will also increase in elevation.  This creates a ‘gap’ in the terrain.  If the borders
are fixed, all edges will remain on the benchwork.

If you make a mistake or don’t like the terrain you’ve created, never fear.  It’s
easily fixed.  To reset the terrain to its original position when you first drew it,
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click on the Reset Terrain button.  To correct an action you just completed, click
on the Roll Back 1 Change button.  This will reset the terrain to just prior to
that action.  You can roll back through multiple actions to try different
adjustments.

This terrain editor allows the user the ultimate in terrain control.  Tunnels are
easily punched through any created mountains.  Objects can conform to any
terrain, in effect, allowing ‘gravity’ to play a role in your computer layout.

The terrain editor can also be accessed from the Edit menu.  Just select the
piece of terrain that you want to edit with the selector tool and then choose
Terrain Editor, or right click on the terrain to bring up the terrain dialog box.
For more information on Conforming Terrain to Objects, see the Arrange menu
section of this chapter.

Note: The terrain editor will not work with any terrain objects found in the
manufacturer libraries.  It only works on terrain made by the user.

PUT SELECTION INTO LIBRARY

To put a selection in the library, select Put Selection in Library by clicking on its
menu item or Toolbar icon.

  

If you’ve previously opened a library, either by using PUT SELECTION INTO

LIBRARY or GET OBJECT FROM LIBRARY, any selected objects are
automatically put into the current library. Use GET OBJECT FROM LIBRARY to
change the current library. If no library has been specified, an OPEN file dialog
appears.
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There are several areas to this dialog box. Refer to OPEN FILE DIALOG

information in “Properties Dialog Boxes” in the What Are the Basics? section
of this manual for more specific information.

• Click an existing library to open and add objects to it. Or, to create a new
library, type the name you want to use to file your selection into the File
name box at the bottom of the dialog box.

• Click OPEN in the lower right corner of the dialog box. A box appears with the
message, “This selection was added to the … library.”

GET OBJECT FROM LIBRARY

ABOUT THE SYMBOL  LIBRARIES

For consistency, all of the symbols are provided in the HO train scale. However,
some of the provided symbols may not actually be available in HO scale and
may have been scaled from other train scales into HO scale.

In some cases, manufacturers only supply symbols for specific train scales, or a
symbol may not be available in all train scales. Please check with the
manufacturer to be certain a particular symbol is available in a specific train
scale.

You can also review MANUFACTURER PARTS LIST under the “Reports” menu
to determine what symbols are available for a particular train scale. The scale
information should be correct but pricing information is subject to change.
Price lists were provided by the manufacturers and were included with the
application as a service to 3D Railroad customers. Please contact the
manufacturers directly regarding current prices, updates or materials questions
you might have.
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For your convenience, a list of manufacturers and phone numbers is provided in
the General Information section of this manual, and can also be accessed from
CREDITS under the “Help” menu.

RESIZING GROUPED SYMBOLS

If you are creating a layout in a train scale other than the HO scale, you can
resize symbols to the desired scale/size.

For scales other than HO, change a symbol’s train scale properties to auto-size
it, or size it manually as follows. For your convenience, here is a list of the
standard train scale ratios.

Train Scale Ratio

1 1:12
3/4 1:16
G 1:22.5
17/32 1:22.6
1/2 1:24
3/8 1:32
O17 1:45.2
O 1:48
On3 1:48
On2 1:48
S 1:64
Sn3 1:64
OO 1:76.2
HO 1:87.1
HOn3 1:87.1
HOn2 1.87.1
N 1:160
Nn3 1:160
Z 1:220

Since all of the symbols are provided in HO scale, you need only divide the HO
ratio of the desired train scale, then multiply the width of the symbol by the
result to determine the new width. Since the symbol’s proportion is maintained
when you resize it, you need not be concerned about its height. To determine
the width of a symbol, select it with the selector tool. The width appears in the
status bar at the bottom of the window.
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For example, to resize a 10" wide symbol to N train scale:

• Using the above ratios, divide the HO ratio by the N ratio to get the scale
factor: 87.1 / 160 = 0.544.

• Multiply the symbol width by the scale factor to get the new size: 10 X
0.5444 = 5.44.

Then, it’s simply a matter of resizing the 10" symbol to the new size of 5.44"
like you would any other grouped object. To increase precision when resizing
or drawing, you can zoom in on your drawing. If you achieve an accuracy
within hundredths of an inch, this is highly accurate and more than adequate.
The result of any greater accuracy is negligible due to limitations of typical
monitor and printer resolutions, so there’s no need for concern if you are having
difficulty making the decimal value comes out exactly the same as your
calculations. Just go with the closest match.

To resize a grouped symbol/object:

1. Select the symbol.

2. Move onto the hollow square handle (unfilled box) at the upper right corner.

3. Drag the resulting outline to the desired size.

“PLACE  HOLDER” SYMBOLS

It’s possible to use a symbol in your layout that isn’t currently provided with
the program.

1. Choose a reasonably close match from the provided symbols.

2. Use the Right Mouse-Button to click on it.

3. Set the reports/database information according to the symbol that you want
represented.

This “place holder” works for planning purposes, and the database information
will appear in shopping lists and other reports.
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To Get a Selection From the Library

Select GET OBJECT FROM LIBRARY by clicking on its menu item or Toolbar
icon.

  

Note: If no library has been accessed previously, the OPEN FILE Dialog appears
here first, as it does with PUT SELECTION INTO LIBRARY. You can now open
an existing library, or create a new, empty library. (Selections can then be added
to the new library via PUT SELECTION INTO LIBRARY.)

The Library dialog box appears.

1. There are six tabs in this dialog box. Select the tab — TRACK, SCENERY,
STRUCTURES, ROLLING STOCK, MISCELLANEOUS, and ALL  — you are
interested in.
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2. Click on the item(s) you want. Note: You can select more than one item by
holding down the Shift key while clicking on the series of items.

3. Click on ADD TO PLAN. You will return to your plan and the item(s) will
appear on both the 2D and the 3D plans.

In addition to Add to plan and “OK,” there are four other buttons at the bottom
of the dialog box:

Open/New: Opens a different library or creates a new library. Click OPEN/
NEW, specify the library’s name in the File name box, and click OPEN. Use PUT

SELECTION INTO LIBRARY to add objects to the newly created, empty library.

Print:  Prints the contents of the current category tab. Note: Click the All tab to
view and print all items in the library.

Properties: Displays the properties of the selected item.

Delete: Deletes an item from the library.

“VIEW” MENU ITEMS

Contains the commands 3D VIEW, ZOOM IN, ZOOM OUT, NORMAL ZOOM, FIT

TO SCREEN, GRID, STATUS BAR, OBJECT SIZES and TOOL PARAMETERS…

3D VIEW

Contains the commands: Show 3D View, Show 3D as Wireframe, Reset
Camera, Birds-Eye View, Left Side View, Right Side View, Front View, Back
View, Lighten and Darken.
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SHOW 3D VIEW

Automatically creates and displays a 3D view of your current drawing.

Select SHOW 3D VIEW by clicking on its View menu item or Toolbar icon.

 

 

The 3D view will display a backdrop, benchwork, and any tracks and other
objects you have already placed on your 2D plan. Note: To display more
objects on your 3D view, you must first place them on your 2D plan. For more
control over what appears in the 3D view, use multiple layers since objects on
hidden layers do not appear in the 3D view. This is particularly useful on slower
systems because it gives faster display updates.

To move around in the 3D view: There will be times you want to move around
the 3D window. There are several ways to do this:

1. Use the movement arrows on the Toolbar.

2. Move your mouse pointer onto the 3D screen and hold the Left Mouse-
Button down. Note: You will probably notice a shift in the view as soon as
you press the mouse button down.

3. Use the PAGE UP and PAGE DOWN keys.

Your options:

• Turn Left: Use LEFT arrow or drag the pointer left.

• Turn Right: Use RIGHT arrow or drag the pointer right.

• Move Closer: Use UP arrow or drag the pointer up.
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• Move Away: Use DOWN arrow or drag the pointer down.

• Move Up: Use SHIFT+UP arrow, use SHIFT while moving the pointer, or use
the PAGE UP key.

• Move Down: Use SHIFT+DOWN arrow, use SHIFT while moving the pointer,
or use the PAGE DOWN key.

• Move Left: Use SHIFT+LEFT arrow or use SHIFT while moving the pointer.

• Move Right: Use SHIFT+RIGHT arrow or use SHIFT while moving the pointer.

• Move Faster: Drag the Arrow pointer farther from center.

• Tilt Forward: Use CTRL+UP arrow.

• Tilt Backward: Use CTRL+DOWN arrow.

• Tilt Left: Use CTRL+LEFT arrow.

• Tilt Right: Use CTRL+RIGHT arrow.

• Look Up/Down: USE THE LOOK DOWN arrow or hold CTRL down while
pressing the Left Mouse-Button.

SHOW 3D AS WIREFRAME

Automatically shows objects on your 3D view as wire-frame images. Note: On
slower systems, this will let you walk around the 3D view more quickly.

Select SHOW 3D AS WIREFRAME by clicking on its menu item or Toolbar icon.

 

 

Note: To return to a solid 3D view of your objects, re-click the SHOW 3D AS

WIREFRAME, and click on either its menu selection or on its Toolbar icon.
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RESET CAMERA

Resets camera in the 3D view.

Select RESET CAMERA by clicking on its View menu item or Toolbar icon.

Note: Click 2D camera objects to switch 3D views to the clicked camera.

BIRDS-EYE VIEW

Sets the camera to give an overhead or “birds-eye” view of your 3D plan.

Select BIRDS-EYE VIEW by clicking on its View menu item or Toolbar icon.

LEFT-SIDE VIEW

Sets the camera to give a left-side view of your 3D plan.

Select LEFT-SIDE VIEW by clicking on its View menu item or Toolbar icon.

RIGHT  SIDE VIEW

Sets the camera to give a right-side view of your 3D plan.

Select RIGHT-SIDE VIEW by clicking on its View menu item or Toolbar icon.

FRONT VIEW

Sets the camera to give a front view of your 3D plan.

Select FRONT VIEW by clicking on its View menu item or Toolbar icon.

BACK  VIEW

Sets the camera to give a back view of your 3D plan.

Select BACK VIEW by clicking on its View menu item or Toolbar icon.

LIGHTEN

Lightens 3D view.

Select LIGHTEN by clicking on its View menu item or Toolbar icon.

DARKEN

Darkens 3D view.

Select DARKEN by clicking on its View menu item or Toolbar icon.
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ZOOM IN (CTRL+PGUP)
Lets you “zoom” in on a plan to magnify/enlarge it for detailed editing.
Zooming in provides a greater degree of control and precision for fine-tuning
positions and object sizes.

Select ZOOM IN by clicking on its View menu item or Toolbar icon, or by using
its key command. Note: If you use the Toolbar icon, you must then click on
your plan to perform the zoom.

 

 

ZOOM OUT (CTRL+PGDN)
Lets you “zoom” out to reduce a plan and lets you see and work with more of
the plan at one time.

Select ZOOM OUT by clicking on its View menu item or Toolbar icon, or by
using its key command. Note: If you use the Toolbar icon, you must then click
on your plan to perform the zoom.

NORMAL ZOOM (CTRL+HOME)
Returns plan to its normal size.

FIT TO SCREEN

Allows you to see your whole plan at once by reducing it to fit your monitor
screen. Note: Use NORMAL ZOOM to return your plan to its normal size.

GRID

Shows/hides a background grid. Grid lines are helpful in laying out your plan.
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Select GRID by clicking on its View menu item or Toolbar icon. Note: To hide
the grid, re-click the View menu item or the Toolbar icon. To set the grid
spacing, select PREFERENCES under the “Options” menu.

STATUS BAR

Switches the Status Bar, at the bottom of the screen, that displays the various
measurements of your selected object, on/off.

OBJECT SIZES

Switches on/off the small-size display box that appears near objects as they are
drawn and manipulated. This box is referred to as the Status Box, and it tracks
and registers a variety of physical measurements for the selected object.

TOOL PARAMETERS

Set the style, width, color, fill color, pattern and pattern color for all drawing
tools using this dialog box.

“ARRANGE” MENU ITEMS
Contains commands: Send TO BACK, SEND TO FRONT, ROTATE LEFT(90),
ROTATE RIGHT (90), ROTATE (180), ROTATE BY DEGREES, FLIP 2D

HORIZONTAL, FLIP 2D VERTICAL, LOCK, UNLOCK, GROUP, UNGROUP, EDIT

GROUP, EXIT EDIT GROUP, CONFORM TERRAIN TO OBJECTS and RESTORE

TERRAIN.
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SEND TO BACK

Places selected object(s) behind another object(s) on your plan.

To send an object(s) to the back: click on the object(s), then click SEND TO

BACK.

SEND TO FRONT

Brings selected object(s) to the front of other objects on your plan.

To bring object(s) to the front: click on the object(s) you wish to select, then
click on the SEND TO FRONT command.

ROTATE LEFT (90)
Rotates the selected object 90° to the left.

To rotate an object: click on the object to select it, then click on the desired
rotate command. Note: You can also rotate 90° to the left by clicking on the
ROTATE LEFT tool button. Most selected objects can also be rotated by
dragging the “+” sign located near one of the selection handles.

ROTATE RIGHT(90)
Rotates the selected object 90° to the right.

To rotate an object: click on the object to select it, then click on the desired
rotate command. Note: You can also rotate 90° to the right by clicking on the
ROTATE RIGHT tool button. Most selected objects can also be rotated by
dragging the “+” sign located near one of the selection handles.
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ROTATE (180)
Rotates the selected object 180°. To rotate an object, click on the object, then
click on the Rotate 180° command. Note: Most objects can also be rotated by
dragging the “+” sign located near one of the selection handles.

ROTATE BY DEGREES

Allows you to rotate an object by a specified number of degrees. To rotate an
object, click on the object, then click on ROTATE BY DEGREES. Note: Most
objects can also be rotated by dragging the “+” sign located near one of the
selection handles.

FLIP 2D HORIZONTAL/FLIP 2D VERTICAL

These two options allow you to flip 2D objects or track either horizontally or
vertically.  You can select more than one item and flip them, or flip a group of
items, as well. This does not work on 3D objects.
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LOCK

Locks the selected object (group of objects) in place. You will not be able to
alter locked objects.

UNLOCK

Unlocks the locked object(s).

GROUP (CTRL+G)
Converts a group of selected objects into a single unit. You can resize the
grouping as a whole, but you must use EDIT GROUP to make any changes to
individual objects.

UNGROUP… (CTRL+U)
Ungroups the selected grouped unit.

EDIT GROUP

Allows you to edit inside a grouped unit. You can edit each object of the group
separately — rotate, resize, change radius, cut, copy, delete, etc. — without
having to UNGROUP. Select EXIT EDIT GROUP to return to normal editing.

EXIT EDIT GROUP

Applies your EDIT GROUP changes and exits the command.

CONFORM TERRAIN TO OBJECTS (CTRL+T)
This innovative feature will allow you to manipulate terrain placement and how
it interacts with other objects in your layout.  With this feature, you can place
track in the mountains, automatically punching holes in the mountain for a
tunnel.  You can also have your track border the mountain on a ledge and many
other options.

First select your piece of terrain that you created with the Terrain Editor and
move it to the desired location.  Go to the Arrange menu and select Conform
Terrain to Objects.  The terrain will automatically allow for any objects that are
placed in the same area.  Objects include track and any 3D object placed from
one of the libraries.
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If you move an object within the terrain, choose Conform Terrain to Objects to
refresh the 3D view and it will be updated, showing how the terrain has
changed at the object’s new location.  To specify a tunnel, select a track piece
and change its attributes to “tunnel” in the track’s properties.  The terrain
located on the track will now have a hole punched through it for a tunnel portal
or portals.

RESTORE TERRAIN (CTRL-R)
Selecting this option will restore the terrain to its original form. This will cause
all objects currently placed on the terrain to return to the default elevations.

“REPORTS” MENU ITEMS
3D Railroad’s “Reports” feature will provide you with easily obtainable
materials and manufacturer’s parts lists to help you keep track of costs,
purchases and inventory information. The “Reports” menu contains the
commands: CREATE MATERIALS REPORT and MANUFACTURER PARTS LIST.
Note: There is a direct relationship between the Reports Menu items and their
corresponding icons on the Toolbar. You can access an action by choosing it in
either place.

CREATE MATERIALS REPORT

Generates detailed, multipurpose reports of all the materials/objects in your plan.

The Materials Report lists each object by manufacturer, scale, name, part
number, and price. It also computes the total cost of all your materials and can
sort your list in a variety of ways. Every item in your plan is listed individually
in a materials report.

The Inventory Materials Report lists each object by manufacturer, scale,
name, part number, quantity, per-piece price and total cost of that particular
item. It also computes the total cost of all your materials and can sort your list
in a variety of ways. For inventory reports, multiple items of the same type are
listed only once and a quantity count is provided.
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Note: If you want an object included in these reports, you must complete the
object’s Properties dialog box and click the “Show in report” box.

Select CREATE MATERIALS REPORT by clicking on its menu item or Toolbar icon.

  

The Materials dialog screen will automatically appear with a list of your
materials/equipment.

To work with the Materials Report:

1. If the categories of materials/equipment checked on the selection bar at the
bottom of the screen are the ones you wish to view, move to Step #3.

2. If you want to view a different category or set of categories, check your
choices on the selection bar at the bottom of the screen.

3. Select the sort/inventory order by rearranging the choice(s) in the “Sort
order” box. Drag the names to rearrange them. Then, click to place a check
in the “Sort” box. Note: You must also click on the “Inventory” box if you
want an Inventory Materials Report.

4. When you’re satisfied with the categories and sort order of your report, click
on the Print button in the lower right hand corner of the screen.

5. Repeat Steps #2 – #3 until you’ve completed as many sort patterns or
varieties of reports as you want.



Note: To have additional custom items show up in a materials report, you can
create a small “dummy” object in your plan and set its report properties just for
the purpose of including the information in materials reports. For example, for
an electrical control box, simply draw a rectangle to represent the control, then
click the Right Mouse-Button and set the desired properties.

MANUFACTURER PARTS LIST

The Manufacturer Parts List contains product descriptions, part numbers and
prices for track, scenery, structures, rolling stock and electrical parts; as well as
a wide selection of other materials ranging from foam bases and weathering
chalks, to lace curtains and ornate fencing.

You can select any number of these parts and print out a ready-to-go shopping
list, complete with part numbers and descriptions, quantities, total prices and
manufacturer’s name. Note: These price lists were provided by the
manufacturers and were included with the application as a service to 3D
Railroad customers. Please contact the manufacturers directly regarding current
prices, updates or materials questions you might have. Manufacturer addresses
and phone numbers are found under “Credits” on the HELP menu and in the
General Information section of this manual. The manufacturer parts lists are
editable, and you can create your own lists. This lets you easily enter updated
prices and product information.

Select MANUFACTURER PARTS LIST by clicking on its “Reports” menu item or
its Toolbar icon.

  

The Manufacturer Parts List dialog screen will automatically appear with a
display of a manufacturer’s inventory.



To use the parts lists:

1. If the inventory displayed is the one you want, move to Step #3.

2. If you want to view another manufacturer’s inventory, click on the Open/
New window at the lower left corner of the screen and select a parts list.

3. Select the category tab — TRACK, SCENERY, STRUCTURES, ROLLING

STOCK, ELECTRICAL, MISCELLANEOUS, and ALL  — you are interested in.

4. Double click on the inventory item(s) you want. An inventory-sheet icon will
appear to the left of your selection. These checked items are all that will appear
on report printouts. Click the CHECK ALL button to select all items at once.

5. Repeat Steps #3 and #4 until you’ve selected all the items you wish to
purchase from that manufacturer.

6. Click on the Print button at the bottom of the screen.

7. Repeat Steps #2 – #6 until you’ve completed your shopping list.

“OPTIONS” MENU ITEMS
Contains the commands SNAP TO GRID, SNAP TO OBJECT CORNERS, TRACK

SNAP and PREFERENCES.
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SNAP TO GRID

If the SNAP TO GRID command is checked, the nearest edge/point of a drawn or
moved object will snap to the grid when the Mouse button is released.

Select SNAP TO GRID by clicking on its “Options” menu item or its Toolbar icon

Note: You can specify the grid spacing on the “Metrics & Grid” tab or
Preferences, under the “Options” menu.

SNAP TO OBJECT CORNERS

If the SNAP TO OBJECT CORNERS command is checked, the edge/point of a
drawn or moved object will snap to the corner of the nearest object when the
Mouse button is released. Note: In the case of an arc, the end of the arc will
snap to the corner. This option does not work with circles/ovals as they do not
have corners.

TRACK SNAP

When a track end point is positioned near another track end and the Mouse
button is released, the track pieces snap together at the correct angles. Note:
Curve directions are determined by which end of curves are snapped.

Select TRACK SNAP by clicking on its menu item or Toolbar icon

PREFERENCES

Changes the common 3D Railroad options. Click on Preferences and a
Preferences dialog window with five tabs — METRICS & GRID, 3D VIEW,
TRAIN, OTHER and DIRECTORIES appears.

METRICS & GRID TAB

Sets the unit name (e.g. inches, feet, meters, etc.), default train scale and grid
width, height and color.



125
3D Railroad

Units: Sets your measurement preferences: yards; feet, decimal; feet, decimal
inches; feet, fractional inches; inches, decimal; inches, fractional; meter;
centimeters; and millimeters.

Grid:  Sets grid size and whether or not grid is visible. Note: The grid can also
be shown or hidden by using the SHOW GRID Toolbar button.

Color:  Sets the color of the grid. Click on color bar and the Color dialog box
opens. Refer to the “Using Colors and Patterns” in the What Are the Basics?
section of this manual for more specific information.

Default train scale: You have a choice of nineteen scales. This scale appears as
the default scale in the Track Properties dialog box and determines the rail and
tie spacing drawn with the track tools.

3D VIEW TAB

Sets Benchwork texture, Backdrop information, and background color.
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Benchwork texture: Clicking on BROWSE automatically opens the “Textures”
folder for you to select a texture other than the default benchwork texture.
Note: There is a wide range of textures to choose from, such as grass, sand, dirt,
and wood grains.

Backdrop: If you wish to use a backdrop, click the backdrop box. If you would
like to use something other than the default backdrop, clicking on BROWSE

automatically opens the “Backdrop” folder for you to select a different
backdrop. There are several areas to this dialog box. For more specific
information, refer to the OPEN FILE DIALOG information under the “Properties
Dialog Boxes” in the What Are the Basics? section of this manual.

Background Color: The background color applies when the USE BACKDROP

option is turned off. Click on the color bar and the Color dialog box opens
automatically. Refer to the “Using Colors and Patterns” in the What Are the
Basics? section of this manual for more specific information.

TRAIN TAB

Sets the maximum for five track measurements.

• Maximum distance between track connections. If the distance between two
pieces of track is greater than this distance, the test train will stop. Otherwise
it will jump the gap and continue running.

• Maximum elevation gap between connections. If the elevation difference
between connected track is greater than this, the test train will stop.

• Maximum grade percentage. If the grade of any track is greater than this, the
test train will stop.
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• Maximum angle between track connections. If a track connection results in
an angle greater than this, the test train will stop.

• Maximum track bend deformation (0.0 – 1.0) This value determines the
maximum amount the spline and curved track can bend before it’s
considered invalid. The greater the value, the greater the allowable bend.
You will probably want to work with values between 0.01 and 0.10 for
testing layouts. For example, a setting of 0.05 causes the test train to be more
sensitive to sharper bands/curves.

Whenever the test train stops, use the Right Mouse-Button to click it and select
Properties to determine the reason.

OTHER Tab
Sets Snap sensitivity range and Selector tool handle sizes.

DIRECTORIES TAB

Displays/sets the directory paths for Databases, Libraries, Trains & Cars, 3D
Objects, 3D Textures, Backdrops, Textures, Bitmaps, 3DBitmaps, and Patterns.



128 What Are All Those Menus and Buttons?

“WINDOW” MENU ITEMS

The Window menu controls access to the document and library windows. It
handles all of the standard Windows document presentation types.

OPEN 2D VIEW

The command OPEN 2D VIEW lets you reopen a previously closed 2D view of
the 3D view window. It will also give you a new view/version of your existing
2D window. Note: As you add new windows, their names will appear at the
bottom of the “Window” Menu Items window shade.

CASCADE

Selecting the CASCADE command will reposition all your open windows to
a “cascading” view. In other words, the windows will be positioned in a
graduated pattern down the screen, with each window’s title bar position
slightly below and to the left of the preceding window. This makes it quite
easy to keep track of and access each of your active windows.
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TILE

Selecting the TILE command will resize and reposition all your open windows
into “tiles” across your screen. In other words, each of your windows will be in
clear view on your screen, but will be much smaller in order to fit all the
windows into your screen. This view is especially useful when you want to
view your 2D and 3D windows simultaneously.

ARRANGE ICONS

Arranges document-window icons along the bottom of the application window.

“HELP” MENU ITEMS
The Help Menu allows you to access HELP TOPICS, ABOUT 3D RAILROAD,
and CREDITS.
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HELP TOPICS

The Help Menu provides access to the 3D Railroad on-line help/information.
There are two tabs under Help Topics: the Contents tab and the Find tab.

      

Contents tab: Clicking on the Book icon will display a list of general areas of
interest. Clicking on one of those areas displays a list of help topics specific to
that subject. Clicking on a topic displays a detailed set of instructions and
information appears. Note: Clicking on the “?” icon on the main contents
screen will bring up complete table of contents.

Find tab: Clicking on the Find tab displays the Find Setup Wizard screen. Use
this screen to set up the FIND capabilities for your application.

ABOUT 3D RAILROAD CONCEPT AND DESIGN…
Displays basic information about the program such as its name, version
number, and copyright information.

CREDITS

Displays information about the Abracadata team/staff, artists, programmers, and
a list of the manufacturers.


